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IMAGE RESIZING 
by Tony Mason          March 25, 2011 

 

If you want to skip all the bally-who and get right to instructions for the program you are interested, use the 

links below. However, I’d recommend that you read the whole thing, not just because I wrote it, but because it 

may give you insight into how easy and complicated its to resize images using a variety of different software.  
 

 Why do you need to change the size of your image 

files? Most of us now have a camera with a resolution of 

around 10 megapixels. That would be 5000 pixels on the 

long side and 2000 pixels on the narrow (your actual pixel 

dimensions may vary). 5000 times 2000 equal 10 million 

or 10 megapixels. This is far more information than most 

of our monitors can display accurately. When you look at a 

full scale image on your monitor, and you want to see the 

whole image, the program that you are using (and/or the 

monitor itself) has to downsize, or interpolate, it. They 

don‟t actually do anything to the file, just resample it so 

the entire thing fits on the screen for you to view at some 

percentage (a 100% view is when you are looking at one 

pixel of image per one pixel on the monitor – on a large 

file, you may be looking at 20 pixels of image per one 

pixel on the monitor, meaning that 19 pixels are not being 

seen). 
 

 So why resize it if I can see the entire thing? Well, as 

mentioned earlier, it has to do with accuracy. You want 

your images to look their best, and by resizing it yourself, 

you allow the viewer to see the photo the way you want it to look, not how some program/

display device (that tries to make things look “average”) would. By changing the pixel 

dimensions for the specific output device (i.e. monitor, projector, etc.) your image is now 

designed for that device and will look its best. 
 

 Another reason to resize is the actual file size, usually measured in kilobytes or megabytes 

(not to be confused with megapixels). You could take a 10 megapixel image and reduce the 

actual file size by using compression (referring to the jpeg or .jpg file type/format), or quality of 

the image. If you took that 10mp image, which let‟s say has a 2 mb file size, and reduced it 

down to 350 kb (by using a low quality setting when saving/exporting), the number of pixels 

remains the same but it would look pretty bad. Lots of detail would be lost, smooth color 

gradations gone – it would look posterized. 
 

 By reducing the number of pixels first, you naturally reduce the overall file size. Then you 

can change the compression/quality to get the file size down smaller without a great loss of 

quality/detail. This is of particular importance when sending an image file by email, or posting 

on a web site/page, as your receiving party may not have high-speed internet to and it could 
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take minutes of time to download it instead of seconds. 
 

 There are many reasons you may want to downsize (or even upscale) your images and by 

doing it yourself, you control how the image looks.  For our OCPA competitions, we are using a 

digital projector that has a native resolution of 1024 pixels (wide) by 768 pixels (tall). If your 

image file contains more pixels than this, the projector has to down sample to get it to fit on the 

screen and it may or may not do a very good job of it. So if you size them yourself… 
 

 So for our internal competitions, we ask you to make the longest dimension no more than 

768 pixels. But if the projector has 1024 wide, why not make the horizontals 1024? Two 

reasons. First, a horizontal image at 1024 pixels wide (and usually around 700 pixels tall) looks 

much bigger than any vertical image that can only be as large as 768 tall (and usually 3-400 

pixels wide) and thus has more impact. Unfair advantages for the horizontal images, as verticals 

don‟t jump off the screen as well because they are smaller. Second, it is more complicated to 

remember two different pixel requirements for horizontals and verticals, so keeping it simple, 

768 pixels period for the longest side (it is bad enough that different competitions outside of 

OCPA have a myriad of different requirements). 
 

 So why do we need to make the actual file size 350 kilobytes or smaller? Two reasons. First, 

download time. Second, for all practical purposes, when the file is larger than 350kb, you 

visibly (when projected under normal circumstances) do not see any difference between it and, 

let‟s say, a 2mb image, so why bother with a large file? (Plus it takes extra time for the program/

projector to render the file thus making the transition from one image to the next take longer.) 

GETTING STARTED 

 Using the image editor (program) of your choice, go ahead make any changes to the photo 

that you believe makes it better - crop; adjust the exposure and color; add any special effects 

(filters); etc. (It is recommend that you work on a copy of the image, that way you always have 

the original untouched photo to fall back on.) Note: some OCPA competitions may require that 

you do very little image manipulation, others you can change those pixels until your heart‟s 

content - consult with the particular competition rules for more information on what can and 

cannot be done. 
 

 Once it is all adjusted and you are satisfied, we need to resize it and save it as another 

version (so we should end up with three files of the same image: one – the original from the 

camera/scanner; two – the file we have made all are adjustments to and; three – our resized 

image for competition (which will need to be renamed as per competition specifics). 
 

If you choose to use one of the following methods to resize your images for OCPA 

competitions that do not allow you to completely control the pixel size and/or the compression/

quality, please include a note in your email competition entry that you used whichever particular 

method and you did not have any other choices. But it is recommended that you find/use a 

The short of it: for all internal OCPA electronic competitions, the pixel 

dimensions are to be no larger than 768 pixels on the long dimension and the .jpg 

file size should not exceed 350kb. 
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method that does allow you that control (some of which are free and listed here). 
 

Note: not all of the programs listed below can open/manipulate every type of image file, although all should 

work on jpeg image files. You will need to research yourself if you can use said programs with your image files.  

 

Pixlr (a flash based, web application – found on OCPA‟s website) 

If you have a reasonably fast 

internet connection (and have Adobe‟s 

Flash installed, which most of you do), 

this free web application will remind 

you a lot of Photoshop. It does layers 

(except for adjustment layers), layer 

masks, has history and a lot of similar 

features (plus the layout is reminiscent 

of) Photoshop. 
 

Once you have done 

your editing and making 

sure you have saved 

(making sure you give/

gave the file a new name so you do not over-right the original file), it‟s time to resize. On the 

menu bar, go to “Image” then choose “Image Size…” and when the dialog pop-up window 

appears, type in “768” in either the width or height box (depending on which is the long 

dimension). Make sure “Constrain Proportions” is checked. Click OK. 
 

Now that it is resized, we need to save it with compression/quality as a jpeg. Go to (on the 

menu bar): “File” then “Save”. Decide where you‟re going to save it to (recommend “My 

Computer”, but Flickr and Facebook, plus a few other 

places, are options). Give the image a new name (check 

the rules for the competition you are entering for the 

proper file name convention), choose “JPEG (Good for 

most photos)” and move the slider left and right to select 

the quality/compression setting. Watch the numbers just 

above the “OK” button, this shows you‟re the size of the 

file. For OCPA competitions, you want it as close to 350 

kb sweet spot as you can get it without going over (every image will require a different amount 

of quality/compression). 
 

When you click “OK” (assuming you selected “My Computer” as your save to choice), a 

“Save As” dialog box will appear. Click the “Browse Folders” down arrow button in the lower 

left of the dialog box and it will open into the typical Windows browser. Browse/navigate to 

where you want to save your image to and then click “Save”. It should now be saved to your 

location, so you can go ahead and close out Pixlr (or work on other images). 
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Paint (for Windows) 
 

You know this program, it‟s that small “art” program that is included in Windows all the 

way back at least to Win „95. While there is not a whole lot you can do with it (as far as 

standard photography manipulation as we have come to know it), you can use it for basic 

resizing – although you have no control of jpeg quality/compression. Fortunately those of you 

that have Windows 7, resizing images is relatively easy, but if you are running Vista or XP, it 

should only be used for resizing as a last resort. 
 

 Since most of us have probably forgotten how to open this program, go to the “Start” button, 

then “All Programs” then “Accessories” then “Paint”. Once you have the program up and 

running and have opened the image you want to resize (on the menu bar: “Open” then browse/

navigate to your image), we can resize. 
 

Windows 7 

In the Ribbon, on the “Home” tab, in 

the “Image” group, click “Resize” and a 

dialog box 

will open. 

Select the 

“Maintain 

aspect ratio” 

check box (so 

the resized picture will have the same 

aspect ratio as the original). Then in the 

“Resize” area, click “Pixels” and type in 

the new size (768) in either the horizontal 

(width) or vertical (height) box (depending on which is the long dimension). 

The program will automatically fill in the other dimension for you 

maintaining the correct aspect ratio. Click OK. 
 

 Now that it is resized, we need to save it. Click on the button to 

the left of the “Home” tab (kinda looks like a document with a little 

down arrow to the right of it), a drop down menu will appear. Place 

your cursor on “Save As” and another fly-out menu should appear. 

Click on “JPEG picture”. Browse/navigate to where you want to 

save the file to, and give it a new name (check the individual 

competition rules for file naming conventions). Unfortunately we 

have no way to control the compression/quality amount, so we 

have to take whatever it gives us (larger or smaller than that magic 

350kb). 
 

Windows Vista 

 If you are forced to work with this older version of Paint, you got to know some math as we 

have to work in percentages instead of actual pixel dimensions. To put it simply, I would only 

use this program (for resizing) if it was absolutely my only choice. 
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 After launching the program (“Start 

Button” then “Accessories” then “Paint”), 

and opening your file (“Open” then 

browse/navigate to file location), on the 

menu bar go to “Image” then “Resize/

Skew”. Now for the math, you have to 

reduce by percentage. Honestly, I don‟t know of an easy formula to 

figure this out, but you would enter the same percentage in both 

horizontal and vertical (to maintain proportions). You have to 

use whole numbers, no decimal places. 
 

If you get the percentages figured out, then to save the image, 

go to “File” then “Save As”. You do have the choice to change 

the file type (jpg, tiff, bmp, etc.), for our use choose jpg – but 

you do not get to choose the compression/quality it uses. Also in the dialog box, click the 

“Browse Folders” down arrow 

button in the lower left of the 

dialog box and it will open into 

the typical Windows browser. 

Browse/navigate to where you 

want to save your image to and 

then click “Save”. It should now 

be saved to your location, so you 

can go ahead and close out Paint 

(or work on other images). 
 

Windows XP 
Basically the same issues as 

with the version supplied with 

Vista with the exceptions of: 

instead of going to “Image” then “Resize/Skew”, its “Image” then “Stretch and Skew”; and the 

“Save As” dialog doesn't need to have the “Browse Folders” button, it‟s already open. Just 

remember that when you “Save As”, give your image file a new name so it is a copy (consult 

the particular image competition rules for the file name convention). 

 

Windows Photo Gallery (for Windows: Vista) 
 

 Don‟t get this confused with Windows Live Photo Gallery 2011, which is an update (see the 

next section). It is highly recommended that you download/upgrade to tthat version as this one 

is very limited for our resizing purposes. 
 

 Select the image you want to resize and select “Email”. From the drop-down menu in the 

dialog box, select “Small: 800x600”. Note that the file size is displayed below. Unfortunately, 

as stated above, this program is very limited and you have no choices in pixel sizes and 

compression/quality. Now click “Attach” and it should open up your default email program and 
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create an email with this file attached. 
 

 Now you could just email it to 

yourself, but why? Either click and drag 

the attached file to your desktop (then 

move it to the folder of your choice) or 

right click on the attachment and “Save 

As…”, and then browse/navigate to 

where you want 

to save it to. 

Then close the 

email without 

sending/saving. 

Go to where 

you saved the file to and rename it according to the competitions suggesting file naming 

conventions. 

 

Windows Live Photo Gallery 2011 (for Windows: Vista & 7) 
 

 Like Google‟s Picasa, Microsoft‟s free 

image editor has many features (some Picasa 

doesn‟t have and some Picasa has but Live 

Gallery doesn‟t). 
 

 Resizing is relatively straight forward. 

Select the image you want to resize, go to: 

“File”> “Resize…” or Right Click on the 

image you want to resize and choose 

“Resize…”. From the “Select a size:” drop-

down menu, select “Custom” and then type 

in “768” (without the quotes) into the box 

(this will be the size for the longest dimension). 
 

 The program should automatically put the image into the 

same folder/location that the image originated from, but if it 

doesn‟t or if you want to save it to a different spot, click on the 

“Browse” button. Then click on “Resize and Save”. The file will 

automatically be saved as a jpeg (using the same file name as 

the original, but with the pixel dimensions in parentheses - so it 

will be copy), but unfortunately there is no way to control the 

compression/quality. Now browse/navigate to where the file is located and rename it in 

accordance with the particular competition you are entering‟s naming convention. 
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Microsoft Office Picture Manager (included with Microsoft Office 2007 – for 

Windows: XP, Vista & 7) 
 

 This image organizer and editor (more 

photograph friendly than “Paint”) will allow 

you to do standard cropping; it also has 

some basic editing features. But more 

importantly for us (and this topic), it allows 

resizing and some compression/quality 

choices. 
 

 Select the image you want to resize, the 

on the menu bar, click on “Picture” and 

choose “Resize…”. A menu/panel should 

open on the right side of your display with 

our resizing options. 
 

 Under the “Resize settings”, select the radio button for “Custom width x height:” and type 

“768” (without the quotes) in both the width and height boxes (don‟t worry, it will not distort 

the image and make your rectangular image square). Look a little farther down the panel and 

notice the “Size setting summary” area. It will display the original pixel dimensions and the 

new ones. Go ahead and click “OK”. The program will create a new copy of your image in the 

new pixel dimensions. (In the off chance you do mess up the pixel dimensions, just Right Click 

on the new image that was created and select “Discard Changes”). 
 

 Now that we have resized the image pixel wise, let‟s change the actual file size 

(compression/quality). Go to “Picture” on the top menu again and click “Compress Pictures…” 

from the drop-down menu (or click on the drop-down menu available on the top of the “Resize” 

panel). On the right side of the display, the “Resize” panel has been replaced with the 

“Compress Pictures” panel. You now have 4 choices. While there is no custom setting, at least 

when we click on the different radio buttons, down lower on the panel you‟ll see an “Estimated 

total size” area that shows the original file size and the compressed size. Use whichever of the 4 

that gets you the closest to that magic number of 350kb. 
 

Don‟t forget to rename your new image file using a file naming convention for the particular 

competition you are entering. 

 

Microsoft Image Composer 1.5 (included with Microsoft FrontPage 2000) 
 

While it is highly unlikely that any of you have this particular program as it was included 

with Microsoft‟s web development program, FrontPage, since I had it and still use it from time 

to time, I‟d include it here. 

Assuming you have applied any and all fixes to the image that you deem necessary to make 

it better (and did your “Save As”, thus making a duplicate file and keeping the original safe), on 

the left menu bar, click on the “Arrange” button. 
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On this pop-up menu, go to the “Scale” section, make sure 

“Pixels” are the “Units” of choice and that “Keep aspect ratio” 

is checked. Go ahead and type “768” into which ever is the 

longest dimension (Width or Height - without the quote marks 

of course) and click “Apply”. 

You can now close the “Arrange” dialog box if you want to 

and go up to “File” and “Save As”. In this new dialog box, make 

sure that the file is going to be 

saved to the proper place (it 

should put the image in the same 

location where you got it from, 

but if you want to verify, 

navigate/browse in the “Save in:” drop-down menu), and give the 

image a new name according to which ever naming convention for 

the competition you are entering. Make sure the “Save as type:” is 

“JPEG (*.jpg) an leave the “Color format:” in the default “-True 

Color-” (probably the only choice you will have in this drop-down 

menu). 
 

The next part is hit-and-miss. For the highest quality you can 

get, un-check “Compression”, but more than likely the file size will 

be too big. Unfortunately this program does not tell you what the 

file size will be, you have to do it, browse/navigate to the file and check the size manually and if 

it is too high or too low, do the whole thing over. So with “Compression” checked, move the 

“Amount” slider. “1” is almost like no compression. “100” is the highest compression/lowest 

quality/smallest file size. It will probably take you a few tries to get the file size you want and 

again, unfortunately, every image requires a different compression/quality amount. Click 

“Save” and the file is renamed, compressed and put into the folder where you wanted it. 

Assuming that you got the compression you wanted, go ahead and close the image and if it asks 

you if you want to save, tell it no (or you will overwrite the original working file). 

 

Picasa 3.8 (for Windows: XP, Vista & 7) 
 

 Using Google‟s Picasa, we will be able to resize our pixel dimensions, adjust our file size 

(quality/compression) and make a duplicate file all from one dialog box. 
 

 Assuming you have made all the changes needed by your image, we need to EXPORT the 

picture. You can either go up to “File” on the top menu bar and choose “Export Picture to 

Folder…” from the drop-down menu or on the panel across the bottom there is a Button with a 

folder icon labeled “Export”. Either way, open the Export dialog box. 
 

 Now we need to make some decisions. First, where are we going to save the image to 

(“Export location” & “Name of exported folder”). It should automatically try to put the image 

in the same place it came from (but just don‟t blindly assume that it is correct, give it a quick 

look-see to confirm it is going to where you want it to go). If you want it to go somewhere else, 
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select the “Browse” button and navigate to where 

you want to store it. 
 

Next is the part where we choose how many 

pixels we want on the longest dimension (“Image 

size”). In the “Resize to” box, type in 

“768” (without the quotes). Don‟t use the slider as 

it gives preset sizes, none of which works for us. 
 

Our next decision is the “Image quality” or how 

big the file will be kilobytes and the overall 

quality. Smaller file size, less quality – larger file 

size, higher quality. We want to get to that sweet 

spot around 350kb. Unfortunately we have no 

way to tell what the file size will be until after we do it. 
 

There are a few preset choices in the drop-down 

menu, but it is suggested that you start with “Custom” 

and take the slider all the way to the right or 100. We 

always want the highest quality image we can get, but we 

have to trade it off with file size. And just to add to the 

confusion, every image needs a different quality setting 

to get close to that magic 350kb. 
 

Go ahead and click “Export‟. A window should open (if not you will need to navigate/

browse using Windows to wherever you saved the file to). Check file size to see if it is too big 

or too small (how close did it come to the 350kb). One way to do this is to single click on the 

file in question, then Right Click and select “Properties”. If it is not a file size that is acceptable, 

then you will need to redo the process. A bit of a hassle with this hit or miss system, but it is 

workable. Once you get the file/photo resized and compressed/quality, rename the file (right 

there in the “Windows window”) to whatever naming convention called for by the particular 

competition you are entering. 

 

ArcSoft Photo Impression 4 (for Windows: XP, Vista & 7) 
 

ArcSoft provides software that is often times included in a bundle with some hardware you 

have bought (camera, scanner, computer, etc.). It contains good basic editing tools. 
 

For our subject, were assuming that you have an image open and have performed any or all 

tasks to render your image into a state that you feel makes it better and that you have “Save As” 

so your not working on the original file. On the left menu bar, click “Edit” and on the bottom 

menu pallet click on “Crop/Resize”. 
 

By default, the crop box should be around the entire image. If you want to crop, now is the 

last chance to do so. Type in “768” (without the quotes) into either the “Width” or “Height” 

depending on whichever is the long dimension. Make sure that “Keep Aspect Ratio” is checked. 

Click on “Resize”. 
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Next up is saving this file that has been resized. Click 

on the “Save” button on the left menu panel. On the 

bottom menu panel, select “To File” and then the “Save 

As” button/icon (so we will make an other copy of the 

file, this time with the crop). A pop-up dialog appears 

where you will need to navigate/browse to where you 

want to save the image file (don‟t assume that it will be 

going where you got it from). Type in the new file name 

(see the particular competition‟s rules that you are 

interested in for specific naming conventions) and make 

sure that in the “Save as type:” is “JPEG”. 
 

Now for a little hit-and-miss. There is a slider at the bottom of 

this dialog box for “Quality”. “100” (all the way to the right) is 

the best quality, largest file size, least amount of compression. 

“1” (all the way to the left) results in the smallest file size but at 

the cost of quality due to maximum compression. I would set it 

somewhere around 90 and then click “Save”. 
 

Another pop-up dialog appears asking 

you if you want to add this image to an 

album. That‟s up to you and how you are 

using the program. Click “Yes” or “No” 

and your image is saved. Now you have 

to go find it, check the file size and if it is 

too big or too small, go back to the 

program and do the process over. If you 

do it a couple of times, you‟ll get a feel 

for what quality setting will get you close 

for your images, but remember, to get as 

close to that sweet spot of 350 kb, every 

image will require a different quality/

compression setting. 

 

Jasc Paintshop Pro 8.0 (for Windows: XP, Vista & 7) 
 

 I don‟t own the latest version of Paint Shop Pro (now owned by Corel), but the basic 

resizing adjustments should be the same (from what I can tell on their website). After you have 

finished work on your image, make sure you save (of course you are working on a duplicate file 

so the original is safe and untouched), then on the menu bar, go to “Image”> “Resize…”. 
 

 Note that on top of the dialog box is the original‟s dimensions (don‟t worry about the pixels 

per inch stuff, that‟s only for prints, not what we‟re doing – resizing for electronic use). In the 

“Pixel Dimension” section, if you haven‟t done so already, change the measurement to pixels. 

Then type in “768” in either the width or height box (depending on which ever is the longest 
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dimension). The other dimension should 

automatically change to keep the ratio 

correct. Note: this dialog remembers the 

last setting you had, so make sure that if 

you are going from horizontals to verticals 

that you change the long dimension 

numbers accordingly. 
 

Skip the “Print Size” section and go 

down and make sure “Resample using:” is 

checked. In the drop-down menu button, 

change it to “Bicubic”. Confirm that “Maintain original print size” is 

checked (this will “gray out” boxes that we don‟t need to worry about 

here). Note: while the pixel dimensions are remembered, this box does 

not always stay checked. Click “OK”. 
 

Now that we are resized, it just a matter of saving. On the menu bar, 

go to: “File” then “Save As…” or “Save as copy” (don‟t‟ use “Save” as 

that will overwrite the file you‟re working on). 

Don‟t worry about where you are saving the image 

to, we‟ll do that later, but do change the “Save as 

type:” to “JPEG-JIFF Compliant (*.jpg, *.jiff, 

*.jpeg)”. Then click “Options…”.  
 

Another window (“Save Options”) pop-up. We 

could choose our compression quality here, but 

there is no indication on what the file size will be. 

So, click on the “Run Optimizer…” button in the 

lower left. This opens yet another window (and closes the 

previous two) with two preview image windows on top and a 

three tab menu on the bottom. Choose the “Quality” tab. 
 

In the “Set compression value to:” box (small number, higher 

quality, larger file size, less compression), change the number 

until the “Compressed” value shown under the preview windows 

shows something close to 350, 000 bytes (but not over). Leave 

the “Chroma subsampling:” in it‟s default setting. Click OK. 
 

In the “Save Copy As” pop-up dialog window, now browse/

navigate to where you want save your image to and rename the 

file (using the particular file naming convention called for by the 

competition rules you are entering) – and confirm that it will be a jpeg file type. If your image 

consists of layers, don‟t worry as when we now save, it will be flattened. Click “Save”. 
 

It doesn‟t look like anything happened as we are back to our original (although pixel 

reduced) file. You can go ahead and close it (but I would double check that your copy got saved 

to where it was supposed to go by browsing/navigating to it to verify), but when it asks you if 
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you want to save the file, say NO. This will keep your working file intact because we saved it 

before we pixel reduced it (you did save before resizing it, didn‟t you?). 

 

Adobe Photoshop Elements 8 (for Windows: XP, Vista & 7) 
 

If you want an imaging program 

that gives you a lot bang for the buck, 

this is a good choice. And if you have 

read all of the instructions for 

the other programs up to this 

point, you notice the way you 

resize is 

basically 

the same 

in all - 

just some 

of the 

programs 

let you have more control of the way it is done, so you can get it the way you want it - not how 

automation wants it. While this resizing description was done from Elements 8, it should work 

as well in older versions and the current version 9. 
 

The newer versions of Elements consist of two separate workspaces (almost like two 

separate programs): “Organizer” (Adobe “Bridge” if you are on a Mac, except the latest version 

9 then it is the same as the Windows version), and the “Editor”. For this discussion, were in 

“Editor” and in the “EDIT Full” tab (on the right side of the window, although the resize 

method is the same in the other two "edit modes" ). And assuming you are working on a copy of 

the original file and have finished all of your corrections/enhancements,  and saved, let‟s resize 

for a OCPA competition image. 
 

On the menu bar across the very top, click on “Image” and on 

the drop-down menu, “Resize”  and on the fly-out menu, “Image 

Size…”. A dialog box appears. Now type in the “Pixel Dimensions” 

section type in “768” (without the quotes of course) in either the 

“Width:” or “Height:” - depending on which is the long dimension 

for your image. Ignore the “Document Size:” area (this section only 

applies to prints). In the three check boxes at the bottom, make sure 

all are checked (“Scale Styles”, “Constrain Proportions” & 

“Resample Image”). And from the drop-down menu, select “Bicubic 

Sharper (best for reduction)”, assuming you are making your 

competition image from a larger image to a smaller one. Click “OK”. 
 

We‟re now resized, time to save. Back up to the menu bar and click “File”, then “Save 

As…”.  A dialog box appears and in the “Save in:” drop-down, make sure this new file is going 

to be saved where you want it to go (don‟t assume it will go to proper place, older versions 
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remember the last place you saved to, while newer versions 

remember where you opened the image from). Give the image a 

new file name according to whatever competition you are 

entering‟s file name convention. Make sure it is in the “JPEG” 

format. You have the option of saving this new file to the Elements 

Organizer (this is up to you depending on how you use the 

program). The next section down (“Save:”) has a check box for 

“As a Copy”. Leave this box unchecked because since we gave the 

file a new name, it will be copy. Next section (“Color:”) has a 

check box for “ICC Profile: sRGB IEC61966-2.1”, it should be 

checked by default, but verify. And last, a check box for “Use 

Lower Case Extension”, checked by default (this is up to you, but with the newer operating 

systems, there is no need for upper case file extensions). Go ahead and click “Save”. 
 

A new dialog box appears for “JPEG Options”. Here is where we set 

our compression/quality. Using the slider, move it and watch the 

numbers located under the “Preview” check box. Slide the slider until 

the number is as close to the sweet spot of “350K” as you can get it 

without going over (“352.6K” would be ok, but “370.8K” would be too 

much, use a lower setting). In the “Format Options” check the radio 

button for “Baseline (“Standard”). Now click the “OK” button and we‟re 

done, you can close out the image and start working on another. 
 

Note: under the “File” drop-down, you may have noticed “Save for Web…”. You could have used this 

dialog to save your file, but I find it unnecessary once you know the above method. 

 

Adobe Photoshop CS5 (for Windows: XP, Vista & 7) 
 

 One thing about this program, as far 

as I know, the resizing method has not 

changed since version 6 (CS5 is version 

12). Like everything in Photoshop, there 

are multiple different ways to do things, 

each with small variations in results. I‟ll 

cover two here: manual and automated. 
 

Manual 
 If you read the instructions for 

Elements (you did, didn't you?), you 

should know how to do this although 

some of the wording may be different. 

For those of you who didn't read them, let‟s get started. Assuming that 

you are working on a duplicate image (keeping the original safe) and 

have made all of your image improving adjustments, make sure you 

have saved before continuing. 
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 On the top menu bar, click on “Image” and on the drop-down menu go to “Image Size…”. In 

the pop-up dialog box type into either the “Width:” or “Height:” “768” (without the quotes of 

course), whichever is the long dimension. Make sure “pixels” is selected and your other 

dimension should change automatically (if not, make sure “Constrain Proportions” is checked 

near the bottom of the dialog box. Ignore the “Document Size: section as this is for prints and 

irrelevant for what we are doing. As mentioned, “Constrain Proportions” should be checked 

along with “Resample Image:”. From the drop-down menu select “Bicubic (best for 

reduction)”, assuming your original image is of a larger pixel dimension. Click “OK”. 
 

 In order to get the most colors to work on (and give us smoother/gradients, more color detail 

in the print, etc.), a lot of us that have the capability will set our cameras to shoot in the “Adove 

RGB (1998)” color space mode. And if you are working in Adobe Photoshop Lightroom, it uses 

the color space “ProPhoto RGB” by default (a color space with even more color latitude). I try 

to work on my images in the highest quality color space I can when editing (before changing 

the pixel dimensions/size) so I achieve the best gradients/color information possible - even 

though today‟s printers and especially monitors can not take full advantage of that - but my files 

will be much more useable in the future and it costs me nothing more than a couple of clicks 

now. 
 

 Since this is the first program mentioned, in this document about resizing, that uses multiple 

color spaces (at least that I am aware of), we should first change the color space to optimize it 

for use with a digital projector (or even computer monitor). (Even though Photoshop Elements 

works with Camera Raw files, it automatically converts them to 8-bit, sRGB files unless you go 

into the program‟s preferences as select “Adobe RGB”.) On the top menu bar, click on “Edit” 

and go down to “Convert to Profile…”. In the pop-up dialog box, in the “Destination Space”, 

“Profile:” pop-up menu, select the “sRGB IEC614966-2.1” (about a 1/4 of the way down from 

the top of the list). 
 

 Next we need to change the “Bit Mode”. Those of us that have the option to shoot our 

images in a raw format, will either have 12 or 14-bit files (more bits, more information to work 

with) - although Photoshop considers anything over 8-bit to be a 16-bit image file. But our 

digital projectors (and computer monitors) currently only display 8-bit, So if I have a 14-bit 

image and my display only shows 8, what benefit does it do me?  My prints will have more info 

to work with and in the future the displays will catch up (assuming I can afford to get one). 

Anyway, go up to “Image” on the top menu bar and then “Mode”. Select “8 Bits/Channel”. 
 

 Honestly, I do not know if there is a difference in quality by doing “color space” first then 

“bit mode” or visa-versa. But I‟m sure someone out there knows of a technical reason to do one 

method over another.  
 

 If you are running a version older than CS5, you will need to flatten your layers (“Layer” 

then “Flatten Image”), assuming you are using layers. But in CS5, there is no need. Now on the 

top menu bar, click on “File” then “Save As…”. CS5 should show the same folder whence you 

got the image file in the first place, older version usually remember the last place you saved a 

file to. But to be safe, verify by browsing/navigating to where you want to save the file to. 

Rename the image file according to whichever OCPA competition‟s naming convention you're 

entering. Make sure the “Format:” is “JPEG (*.JPG, *.JPEG, *.JPE). Note (in CS5) that when 
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you changed from the default (if you had layers) 

“Photoshop (*.PSD; *.PDD)” to jpeg, a warning icon 

appears in the “Save Options” section and at the bottom 

of the dialog window. This is just an indicator that 

Photoshop will save this image with layers by flattening 

it automatically into as single layer when converting to 

jpeg. And if we didn't give it a new name, it would 

automatically add the word “copy” to the file name 

when saving. But since we already are giving this file a 

new name, it is no problem. In older versions, we 

manually flattened the image. Verify that the “ICC 

Profile: sRGB IEC61966-2.1” is checked (see 

paragraph above) and  “Use Lower Case Extension” 

also is checked. Click the “Save” button. 
 

A new dialog box appears for “JPEG Options”. Here is where we set 

our compression/quality. Using the slider, move it and watch the numbers 

located under the “Preview” check box. Slide the slider until the number is 

as close to the sweet spot of “350K” as you can get it without going over 

(“352.6K” would be ok, but “370.8K” would be too much, use a lower 

setting). In the “Format Options” check the radio button for “Baseline 

(“Standard”). Now click the “OK” button and we‟re done. 
 

 Your image is now saved to wherever you saved it to (most of the time, I like to verify that it 

went to where I wanted it to go, „cuse sometimes I get in a hurry and it gets saved to who knows 

where). You can go ahead and close your image (note in CS5 our layers are still there), but it 

has been resized, so when it asks me do I want to save, just say no. If you have forgotten to save 

before you started the resizing process, just cancel out of the close dialog (assuming you started 

to save), open up the “History Palette/Panel” and undo the “Image Size” step. Now go ahead 

and close/save or save then close. 
 

 And yes, Photoshop has the same “Save for Web & Devices…” that was mentioned in the 

Elements description, but as stated there, once you know how to use this method there is no 

really good reason to use this particular dialog for this resizing/saving purpose. 
 

Automated (Actions) 
As you have read this document, you probably picked up on the fact that I like the “have full 

control over everything” method. But this is a freaking $1000 (full retail - extended version, 

$700 for the standard) program. Isn‟t there a way to have control and yet give me a faster way 

to do this? Yep-er! 
 

Before I give you a fully automated way to resize, let‟s set it up with a semi-automated 

method. Of the 9+ programs thus far described, 6 of them require that you know which side of 

the image is the long dimension (Windows Live Photo Gallery 2011, Microsoft Office Picture 

Manager & Picasa 3.8 are the exceptions). I know that this doesn't sound like much, but when 

you are resizing multiple images in a hurry to meet a deadline for entry, it is easy to get which 

side is which for which image a bit confused. 
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For Photoshop, there is a way to 

resize not knowing which is the long 

dimension and it is called “Fit Image”. 

On the top menu bar, click on “File” and 

go down to “Automate” then “Fit 

Image…”. A new dialog box appears, 

and in it type “768” (without the quotes) 

into BOTH the “Width:” and “Height:” 

boxes and click “OK”. (This dialog box 

is referred to as “sticky” „cuse it 

remembers what numbers you used last, 

meaning that once it is typed in you 

won‟t have to do it again - assuming you want to keep using the same 

dimensions.) You‟re image is now resized and you can save as described 

earlier. So how is this semi-automated? Well, ok, it‟s not really. But it had 

to be brought up so you know about it for the next part. (Oh, I should 

mention that when it shrinks the pixel dimensions, it uses whatever “Image Interpolation” you 

have set up in the “Preferences” - which I won‟t get into how to set here - normally defaulted to 

the “Bicubic (best for smooth gradients)” setting.) 
 

So how do we take advantage of this “Fit Image” thing? By creating an “action” (some of 

you may think of an action as a macro - a bit of script that tells the program what to run 

automatically). I‟m not going to take the time or space here to describe how to create an action 

(it is actually relatively easy), but I have provided the action for you already pre-

built. If you are reading this text on the website, use this LINK. If you are reading 

this in the .pdf version, you‟ll need to go to OCPA‟s website and once there go to 

the bottom of the page (actually, the bottom of almost any page on our site) and 

click on the “Downloads” link. You‟ll find the link for the action there. The file is 

“OCPA 768.atn”. 
 

Once you have the action downloaded and saved somewhere on your 

computer (where you can find it again for using on other machines or 

upgrades to Photoshop - when you upgrade, you have to reinstall all your 

custom actions, plug-ins/filters, etc.), launch Photoshop (assuming it is not 

already running). Open/find the “Action” palette/panel (if it is not already 

open, go to the main menu bar and click on “Window” and go to 

“Actions”). In the upper-right corner of this palette/panel there is a little 

icon that looks like three lines with a down arrow on the right of them 

(older versions of Photoshop will have a little round circle with a down 

arrow). Click on this icon and a fly-out menu appears. Select “Load 

Actions…” then navigate/browse to wherever you saved the action file to 

and click “Load”. 
 

Once loaded, there will be a new folder in the Action palette/panel 

entitled “OCPA 768”. If you click on the little purple arrow to the left of 
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the folder icon so it points down, you will see what is in the folder, in 

this case “768 pixels”. (If you want to see all the steps in this action, just 

click those little purple arrows.) Highlight (i.e. single click) on the 

action you want to run (in this case “768 pixels”, then click on the “Play 

selection” icon (the right pointing arrow at the bottom of the palette/

panel - looks like the play button on your vcr/dvd/cassette tape player - 

now that dates me though I could have said 8-track). Assuming you have 

a image open and active that you want to run this action on, as soon as 

you click the “Play selection” button, it is done. If you had layers, 

they‟ve been flattened (I assume that you saved your image before you were ready to resize). 

You‟re now ready to “Save As…” (how to do that was described earlier). How easy was that? 
 

Automated (Batch) 
 

Want to make it even easier? (Works best with raw files, read on to find out why.) Now that 

you have the action installed, you don‟t even have to have Photoshop running. Using “Adobe 

Bridge” (it‟s included with Photoshop back through the original CS version - you do use Bridge 

to navigate/browse/manage your images, don‟t you?), you can apply this action to as many 

images as you want to all in basically one click. 
 

With “Adobe Bridge CS5” open and running, navigate/browse your way to where your 

images are stored that you want to use. Assuming that you have more than one in the same 

folder, Ctrl click on the ones you want to resize (so they are highlighted). If the images are raw 

files, do your raw work before you resize. If you have to work on them in Photoshop proper, do 

that now also. This resize action will work on raw files, psd files with layers, tiffs and 

of course good „ol jpegs. 
 

On the Bridge top menu bar, click on 

“Tools” then “Photoshop” then 

“Batch” (don‟t get this “Batch” confused 

with “Batch Rename…”). (I know this will 

work on CS3-CS5, I currently don‟t have an 

older version of the program installed to 

check this out.) When you click on “Batch”, 

it will launch Photoshop if it is not already 

running and a “Batch” dialog box will 

appear. 
 

In the “Play” section, use the drop-down menu in the 

“Set:” box and in our case choose “OCPA 768”. Since there 

is only one action in our set (action folder), the next drop-

down (“Action:”), it is automatically there for us. “Source:” 

should automatically be set for “Bridge” (since that is 

where we launched this from). For this action, I would 

uncheck any of the next four check boxes. Now in the 

“Destination:” section, this is where we want our resized 

images to go. I normally select “Folder”, then using the 
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“Choose…” button, navigate/browse to where I 

want to save these resized images. Uncheck 

“Override Action „Save As‟ Commands” as there are 

no “Save As” commands to worry about in this 

particular action. 
 

In the “File Naming” section, this is where you 

can rename the image files but because, due to each 

competition having a unique naming convention and 

each image has a different title, I tend not to use this 

here (plus I am saving to a new folder just for these 

competition images so I don't have to worry about 

file duplication). So I leave it in defaults: first box “Document Name” and the box to the right 

of it, “extension”. The rest of the boxes I leave blank and the other boxes wherever they default 

to. Go ahead and click “OK”. Zip-zap-boom, your images are resized. 
 

If you are resizing any raw files you will get a lot of options. First, the Adobe Camera Raw 

dialog box will appear. Assuming that you have already done all your enhancements/

corrections/etc. click “Open Image” (or you could do more tweaks if needed). Then when the 

“Save As” dialog appears, you can now give it a new name according to the competition‟s file 

naming convention. Don‟t change the save as destination, it will be in conflict with the action - 

but it should know where to go because the action told it where. And click “Save”. Next the 

“JPEG Options” dialog pops up. You can now decide on the compression/quality as discussed 

earlier in the “manual” method. Go ahead and click “OK”. 
 

This “Batch” stuff is really slick with raw images/files that don't need and additional work in 

Photoshop proper since you have the chance to rename and decide on the jpeg compression/

quality. If you run this action on psd files, it resizes them, but keeps it as a psd file with all of 

your layers intact. Meaning you need to open the file, save as a jpeg (include rename) and 

choose the compression/quality. Tiff‟s to will need to go through the same process. And 

unfortunately if you run this on jpegs, you don't get to choose compression and if you open and 

resave the jpeg with lower compression/quality, it may not be as good as if you opened the 

original jpeg into Photoshop and run the resize action individually instead of in a batch. Bottom 

line, for tiffs, psds and jpegs - I‟d run the action individually instead of in a batch (exception, 

for applications/uses where I don‟t care about the jpeg compression being under a certain 

amount). But our next program has a way to resize, convert to jpeg and control the compression 

all in one dialog box. 
 

Personal Observation: for actually one of the simplest ways to resize images with the most 

control, this explanation on CS5 sure took up a lot of page space. 
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Adobe Photoshop Lightroom 3 (for Windows: XP, Vista & 7) 
 

 This is my primary image organization, global and limited local adjustment program. The 

workhorse in my stable. Once you have done your correction/enhancement work - be it a raw, 

psd, jpg or tiff image file - you‟ll select the images you want to resize and put them either a 

permanent or temporary collection (like “Smart Collections”). You‟re not actually moving the 

file from it‟s location(s) on your hard drive(s), just telling Lightroom that you have an image 

stored somewhere that you want to do 

something to at sometime. 
 

 Open your collection and highlight 

the images you want to resize. Then click 

the “Export…” button in the lower left 

corner. A new dialog box will appear and 

in the upper left corner it will let you 

know how many images you are going to 

export (example: “Export 10 Files”).  In 

the main window, there are numerous 

options indicated by a gray bar. If the 

option section is open, the little gray 

arrow to the left of the option title is 

pointed down. You can close this section 

(or open it) by clicking on that little arrow. 
 

 “Export location” is where you will 

navigate/browse your way to where you 

want to save the resized images to (a new 

folder at some other location, same location 

where the images came from, etc.). You can 

even add these resized images to your 

existing catalog if you choose to. “File 

Naming” is one I skip for this type of 

resizing due to the fact that each image 

needs a different name depending on the 

competition‟s naming convention. 
 

 “File Settings”, now we‟re getting into the meat of it. 

“Format:” is “JPEG” and “Color Space:” will be sRGB. I 

don‟t move the “Quality:” slider because I‟m going to 

check the “Limit File Size To:” box and type in “350” in 

the “K” box (without the quotes of course). Checking the 

“Include Video Files” box doesn't hurt anything here as 

everything I‟m exporting is still images (your choice, on 

or off). 
 

 “Image Sizing”. Check the “Resize to Fit:” box and 
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select “Long Edge” from the drop-down menu. I leave the “Don‟t Enlarge” box clear as 

everything I‟m resizing is taking a large file to a smaller one. Type in “768” (no quotes) into the 

box and select “pixels” from the drop-down menu. “Resolution:” defaults to “240” and “pixels 

per inch” (in the drop-down). It does not matter where these numbers are as it is irrelevant for 

our use. We care about how many pixels by how many pixels - resolution is just for printing. 
 

 “Output Sharpening”. I will turn-on the “Sharpen For:” box and select “Screen” from the 

first drop-down menu and “High” from the “Amount:” one. “Metadata”, “Watermarking” and 

“Post-Processing” I tend to leave in the default settings though I may check the “Write 

Keywords as Lightroom Hierarchy” in the “Metadata” section if I am keeping these resized 

images in my Lightroom Catalog. Also feel free to look at the other settings, even if you are not 

going to change anything at this time. If you think you will be using these particular export 

settings a lot, you may want to save them as a “Preset” by clicking the “Add” button in the 

lower left (under the “Preset” window).  
 

 Now that everything is set, click the “Export” button and voom-de-la-voom (watch the 

progress bar in the upper right corner of the main Lightroom interface window) - your images  

have any Lightroom (and/or Camera Raw adjustments from Photoshop proper) applied, they‟re 

resized, converted to jpg, compression/quality is set not to exceed the sweet 350kb file size and 

they‟re stored in the location of you choice just waiting for you to rename them according the 

competition you‟re entering‟s naming convention. Done! 

 

Conclusion 
 

After reading about resizing images in 11+ different programs (you did read everything up to 

this point didn't you?), you should have come to the conclusion that they all do kinda the same 

thing, and how you do it are all kinda similar. You should now be able to open any imaging 

program and figure out how to resize (and save) your images - although you may not have all 

the tools you want (particularly in the quality/compression settings). The bottom line - it 

depends on you budget on what software you buy, what you‟re going to use it for and how often 

you‟re going to use it (i.e. I would not buy Lightroom just to resize three competition images 

four times a year). You have imaging software on you computer. Your camera probably came 

with some, Windows has some built-in, there are free download programs available on the 

internet and we even have one available on our website. Learn how to use the program you 

have, even if it has limitations, sometime you can figure out how to work around them - just 

give it a try. And have fun, this is supposed to be enjoyable, not work. ;-)  
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